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The easy ways to ensure your Microsoft Office documents and PDF files are fully accessible. The 
session will both demonstrate the experience of using assistive technology to read accessible 
and inaccessible documents from the perspective of blind employees and citizens. Also, it will 
explain how to apply optimal accessibility.  
 
It will cover: 
• The rise of PDF related lawsuits in Florida in 2019 
• How and why some PDFs appear "Blank" to screen reader 



• The cause and consequences of some document being "Untagged" 
• The use and benefits of Semantic markup in documents 
• The benefits of exporting over remediating PDFs 
• The benefits and limitations of using Optical Character Recognition (OCR) 
• The role and consequences of "renderable text" in a "searchable image" 
• Quality assurance testing for Word and PDF 
 
List 3 guaranteed audience takeaways  
• How to prevent PDFs from appearing completely blank to screen readers 
• How to format documents or PDFs so that blind employees and citizens can easily navigate 

them 
• Learn the faster and more effective alternative to painstakingly remediating PDFs for 

Accessibility 
 
IT Business Systems Analyst Senior  
bouton.jones@gmail.com  
My pronouns are he and him 
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Life is too short to be spent 
photographing slides. 

A handout containing all the slides and speaker notes can be found at 
http://bit.ly/2y0p5kJ .  (Someone will post this URL to chat.)

Bouton Jones 2

 

 

Life is too short to be spent photographing PowerPoint slides.  
 
A handout containing all the slides and speaker notes can be found at http://bit.ly/2y0p5kJ (or 
http://www.boutonjones.com/pub/a11y.html .)  Someone will post this URL to chat. 
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Special Thanks to David Ondich.   
 
David Ondich is a huge reason for why I put this presentation together as well and the manner 
and the content.  David is the ADA Program Manager for the City of Austin and he is a user of 
assistive technology.  Over the past two years David and I have been discussing and sharing 
information and perspective on this this topic.  He’s made me aware of situations that are 
otherwise invisible to me and I’ve explained to him the technological causes of his accessibility 
frustrations. 
 
We’ve co-presented on Accessibility together several times.  This session is largely based on that 
content but it’s been expanded an refocused for a more technical perspective. 
 
David Ondich, M.S., is the City of Austin, Americans with Disabilities Act Program Administrator 
and in 2014 was named Legal Subject Matter Expert on the Americans with Disabilities Act. His 
experience and education include 
• 16 Years as ADA Program Manager or Coordinator for Austin and Fort Worth 
• Master’s Degree in Rehabilitation Counselling Psychology from UT Southwestern Medical 

School of Allied Health and 48 Doctoral hours in Rehabilitation Counseling from The 
University of Texas at Austin 

 



He currently oversees municipal compliance with Titles I and II of the Americans with 
Disabilities Act, which includes: 
• Providing feedback on accessibility to electronic information. 
• Reviewing all employee requests for reasonable accommodations; 

Consulting with department personnel regarding legal obligations under Titles I and II of the 
ADA 

• Arranging for accommodations to allow the public access to all city facilities, programs and 
activities 

• Providing training to city personnel regarding obligations under the ADA as amended. 
 
“Nothing about us without us.”  
 
Also 
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Obligatory Overview Slide

• Introduction

• Three identical PDFs examined 
through screen readers

• Microsoft Word

• Remediating PDFs

• Optical Character Recognition

• My Conclusion

• Questions
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Obligatory Overview Slide 
 
IMAGE:  Verbose man surround by a cloud of “Blah! Blah! Blah!” 
 
• Introduction 
• Three identical PDFs examined through screen readers 
• Microsoft Word 
• Remediating PDF 
• Optical Character Recognition 
• WCAG and PDF/UA 
• My Conclusion 
• Questions 
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In My Experience as a Web Developer …
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In My Experience as a Web Developer… 
 
For over ten years I was a professional web developer.   I was very conscientious about applying 
accessibility guidelines.  But on occasion I would be given a PDF to post online and I would post 
it without considering whether it was accessible or not.  My assumption was the PDF was 
accessible and there was nothing I needed to do but post the document and link to it. 
 
My preconception changed a few years ago when David Ondich cam to me for help with PDF 
documents that he had issues with. 
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2019 Florida A11y Lawsuits
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2019 Florida A11y Lawsuits 
  

• One law firm and plaintiff sued multiple counties and municipalities over inaccessible 
websites. 

• A suit against Flager County was filed 6 months after the plaintiff reported the problem. 

• 75% of the IT directors at a Florida conference had seen similar lawsuits. 

• Settlements ranged from $10,000 to $ 19,000. 

• The web pages were not cited as the problem.  It was the PDFs.  
  
CITE:  

• http://www.govtech.com/gov-experience/Flagler-County-Fla-Settles-Website-Accessibility-
Lawsuit.html  

• https://www.newschief.com/news/20190420/ada-compliance-polk-records-vanish-amid-
wave-of-legal-threats    

• https://news.gulfbreezenews.com/articles/city-of-gb-removes-pdfs-from-website/  
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Hurricane preparedness for people with 
special needs

One of the Polk County’s inaccessible documents was “Hurricane 
preparedness for people with special needs.”
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“Hurricane preparedness for people with special needs” 
 
By the way, one of the Polk County’s inaccessible documents was “Hurricane preparedness for 
people with special needs.”  
Polk county opted to remove the pamphlet --- as well as all other PDFs --- from its web site. 
 
Image:  Screen capture of the “Special Needs” page on the Haines City, FL web site. 
 
CITE: https://www.newschief.com/news/20190420/ada-compliance-polk-records-vanish-amid-
wave-of-legal-threats    
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Online-Accessibility Law Moves Many Agency 
Documents Offline
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In response to legal mandates and community pressure, some municipalities and government 
entities have opted to remove content completely rather than spend the necessary time and 
resources to make them accessible. 
  
This is especially dangerous when you consider that some of the content was important 
information that really needed to be shared with the public. 
  
NEWS STORY:  Online-Accessibility Law Moves Many Agency Documents Offline 
CITE: https://www.techwire.net/news/website-accessibility-law-spurs-disappearance-of-agency-
documents.html   
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PDF Benefits
CurrentlyOriginallyBenefits

YYUniversal Viewing

YYControl of the appearance

YYFree to read

Meh!YSecure *

YYQuick and Easy

YYCompact

YFillable

2000Signable

1996Interactive

1994Password protection

2003Multimedia
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"PDF allows the user to view a file precisely—down to the pixel, essentially, of what the author had intended."
- Bob Wulff, Adobe’s Senior Vice President of Cloud Technology

*While many of us consider the format secure, most PDFs can be modified after they are published.

 

 

PDF Benefits 
 
• PDF was created by John E. Warnock, co-founders of Adobe Systems Inc. 
• It was initially launched in 1993 as a proprietary format 
• In 2008, it was released an ISO open standard which means that if Adobe ever goes out of 

business, the PDF format will remain available and supported. 
 
"PDF allows the user to view a file precisely—down to the pixel, essentially, of what the author 
had intended." 
 - Bob Wulff, Adobe’s Senior Vice President of Cloud Technology 
 
“PDF was developed in the early 1990s as a way to share documents, including text formatting 
and inline images, among computer users of disparate platforms who may not have access to 
mutually-compatible application software.[1]It was created by a research and development 
team called Camelot,[2] led by Adobe's co-founder John Warnock.”   
CITE: https://en.wikipedia.org/wiki/History_of_the_Portable_Document_Format_(PDF)  
 
Tabl with three columns, the table headers are:  Benfits, Originally, and Currently. 
 
Original Benefits 
 
• Universal Viewing (regardless of OS or Productivity Suite) 
• Control of the appearance 



• Free to read 
• Secure * 
• Quick and Easy 
• Compact 
 
Over time the following features were added 
 
• Fillable 
• Signable 
• Interactive 
• Password protection 
• Multimedia 
 
*While many of us consider the format secure, most PDFs can be modified after they are 
published. 
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Is PDF the best option?

Bouton Jones

https://www.nngroup.com/articles/avoid-pdf-for-on-screen-reading/

https://www.nngroup.com/articles/pdf-unfit-for-human-consumption/
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Is PDF the best option? 
   
PDFs are good for: 

• printing 

• fillable forms 

• signing 
  
Don’t use a PDF where a web page will do as well --- or better. 
  
Related Usability Articles from the Nielsen Norman Group: 

• Avoid PDF for On-Screen Reading - https://www.nngroup.com/articles/avoid-pdf-for-on-
screen-reading  

• PDFs: Still Unfit for Human Consumption 20 Years Later - 
https://www.nngroup.com/articles/pdf-unfit-for-human-consumption/   
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Three Visually Identical PDFs
They have the exact same content, title, headers, font, and colors.  So how are they different?
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Three Visually Identical PDFs 
  
They have the exact same content, title, headers, font, and colors.   So how are they different? 
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First PDF

NVDAJAWS
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The Scanned PDF 
 
To users of assistive technology, scanned PDFs are blank. 
 
AUDIO:  Jaws and NVDA fail to read this PDF. 
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“Blank” or “Image Only” PDFs

“A picture may be worth a thousand words --- but 
not if it's a picture of a thousand words that you're 
trying to read with accessible technology.”
- David Ondich
ADA Program Manager for the City of Austin

PITFALL:  When you scan a printed document – e.g. a signed contract, police report, corporate 
policy, or anything requested for discovery – it is no more than an image of the hard copy.  It will 
not be accessible to screen readers in its current form.
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“Blank” or “Image Only” PDF 
  
PITFALL:  When you scan a printed document – e.g. a signed contract, police report, 
corporate policy, or anything requested for discovery – it is no more than an image of 
the hard copy.  It will not be accessible to screen readers in its current form. 
 
If you can’t “copy and paste” text, it most likely is an image. 
 
As David has said “A picture may be worth a thousand words --- but not if it's a picture of 
a thousand words that you're trying to read with accessible technology.” 
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Second PDF

Read Text Read Headings Read Lists
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Untagged PDF with Text 
 
Untagged PDFs contain true text but they can’t be navigated. Screen readers can read the 
content but they can’t find the headers or the lists. The tags have been stripped from the 
document.  
 
Audio files: 
• A screen reader reads the text 
• A screen reader fails to read the headers 
• A screen reader fails to read the lists 
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Question: When is a PDF with text an “untagged” document?

Answer 1 of 2:  When semantic markup is not used to tag the 
structural elements in a document, the document is called “untagged.”  
If the source of a PDF is an untagged document, the PDF will also be 
untagged.

Question: When is a PDF with text an 
“untagged” document?

Tuesday, May 7, 2024 15Get the slides and notes at http://bit.ly/2y0p5kJ
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Question: When is a PDF with text an “untagged” document? 
 
Answer 1 of 2: When semantic markup is not used to tag the structural elements in a 
document, the document is called “untagged.”  If the source of a PDF is an untagged document, 
the PDF will also be untagged. 
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Define Tagged PDFTagged PDFs:

1. "Tagged PDF (PDF 1.4) is a stylized use of PDF that builds on PDF's logical structure framework. It 
defines a set of standard structure types and attributes that allow page content (text, graphics, and 
images) to be extracted and reused for other purposes"

(CITE: "PDF Technology Notes“ at https://www.w3.org/WAI/GL/WCAG20-TECHS/pdf_notes.html )

2. A PDF file that -- in addition to text and graphics -- contains meta-data for text-extraction, content-
reflow, document accessibility, geographic information in PDF containing maps, etc.,

With the correct tags, a screen reader can: 

• Understand where headings fall
• Follow the correct reading order
• Identify footnotes & graphics
• Understand the structure of tables
• Complete fillable forms

In most cases, tags are necessary in order to make a PDF file comply with Section 508. 

(CITE: "What is 'Tagged PDF'?" http://stackoverflow.com/questions/6397984/what-is-tagged-pdf) 

Bouton Jones 16

 

 

  
Tagged PDFs: 
  

• Tagged PDF (PDF 1.4) is a stylized use of PDF that builds on PDF's logical structure 
framework. It defines a set of standard structure types and attributes that allow page 
content (text, graphics, and images) to be extracted and reused for other purposes“   
(CITE: "PDF Technology Notes“ at https://www.w3.org/WAI/GL/WCAG20-
TECHS/pdf_notes.html ) 

  

• A PDF file that -- in addition to text and graphics -- contains meta-data for text-extraction, 
content-reflow, document accessibility, geographic information in PDF containing maps, 
etc., 

  
With the correct tags, a screen reader can:  

• Understand where headings fall 

• Follow the correct reading order 

• Identify footnotes & graphics 

• Understand the structure of tables 

• Complete fillable forms 
  



In most cases, tags are necessary in order to make a PDF file comply with Section 508.  
  
CITE: "What is 'Tagged PDF'?" http://stackoverflow.com/questions/6397984/what-is-tagged-pdf  
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Question: When is a PDF with text an “untagged” document?

Answer 1 of 2:  When semantic markup is not used to tag the 
structural elements in a document, the document is called “untagged.” 
If the source of a PDF is an untagged document, the PDF will also be 
untagged.

Answer 2 of 2: When you print a document to PDF.  The text is saved to 
the PDF but the tags for indicating structure are lost.  

Question: When is a PDF with text an 
“untagged” document?

Tuesday, May 7, 2024 17Get the slides and notes at http://bit.ly/2y0p5kJ
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Question: When is a PDF with text an “untagged” document? 
 
Answer 2 of 2: When you print a document to PDF.  The text is saved to the PDF but the tags for 
indicating structure are lost.   
 
One surprising exception is tables.  I printed (to PDF) a Word document containing a table.  Both 
cells of the table included multiple lines of text.  I expected the screen reader to ignore the table 
cells and read the entire content left to right.  But both JAWS and NVDA read all the line of text 
in the first cell before reading all the lines of text in the next cell. 
 
I tried using Word’s column function.  NVDA was able to read a two column PDF printed from 
Word correctly. 
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Question: When is a PDF with text an “untagged” document?

Export to PDF

Never Print to PDF!

Tuesday, May 7, 2024 18

Always Export to PDF instead

Get the slides and notes at http://bit.ly/2y0p5kJ
Bouton Jones 18

Never print to PDF.  Always export to --- or save as --- PDF.  That way the semantic formatting (the tags) will be included.  
Export to PDF is a better option than Save as PDF.

 

 

In Review (Slide 2 of 5): Save to PDF 
 
TABLE: Two column table comparing Print to PDF with Export to PDF. 
 
Never print to PDF.  Always export to --- or save as --- PDF.  That way the semantic formatting 
(the tags) will be included. 
 
Export to PDF is a better option than Save as PDF. 
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Third PDF

Read HeadingsRead Text Read First List
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Tagged PDF with Text 
 
Bouton explains (and demonstrates) navigating a PDF with text and navigation (such as headers 
and lists.) 
 
Screen readers (such as Jaws and NVDA) will identify headers and list in a tagged PDF. 
 
Audio files: 
• A screen reader reads the text 
• A screen reader reads the headers 
• A screen reader reads the first list 
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Two Ways to Make Accessible PDFs:

1. Exporting 2. Remediation

We’ll return to semantic markup in just a bit.

Bouton Jones 20

 

 

Two Ways to Make Accessible PDFs: 
 
1. Exporting 
2. Remediation 
 
The word remediation looks like it’s written in blood.  It uses a decorative font that belongs on a 
poster for a horror movie or on the cover of a horror comic book. 
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Four Steps in Exporting to PDF

1. Create fully accessible source documents (E.G. Microsoft Word 
documents “.docx”) or web pages.

2. Validate that the Office documents or web pages as fully accessible as 
possible.

3. Export the Office documents or web pages into PDFs.

4. Validate that the PDFs are as accessible as possible.

Bouton Jones 21

 

 

Four Steps in Exporting to PDF 
  

• Creating fully accessible source documents (e.g. Microsoft Word documents “.docx”) or 
web pages 

• Validating that the Word documents or web pages are truly and fully accessible.  (Make 
them as fully accessible as possible.) 

• Exporting the Word documents or web pages into PDFs 

• Validating that the PDFs are truly and fully accessible 
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Microsoft Word Accessibility

 

 

Microsoft Office Accessibility (title slide) 
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Tagging and Semantic Markup

Semantic Markup (or “Structural Markup”):

1. (In Technical and Business Writing) naming sections of text according 

to the structural role they play in the document. (CITE: “Highlighting 

and Emphasis” in Online Technical Writing by David McMurrey at 

https://www.prismnet.com/~hcexres/textbook/)

2. (In Information Technology) the use of a markup language such as 

HTML to convey information about the meaning of each element in a 

document through proper selection of markup elements, and to 

maintain complete separation between the markup and the visual 

presentation of the elements contained in the document. 

Bouton Jones 23

 

 

Semantic Markup (or “Structural Markup”): 
  

• (In Technical and Business Writing) naming sections of text according to the structural role 
they play in the document. (CITE: “Highlighting and Emphasis” in Online Technical Writing 
by David McMurrey at https://www.prismnet.com/~hcexres/textbook/ ) 

 

• (In Information Technology) the use of a markup language such as HTML to convey 
information about the meaning of each element in a document through proper selection 
of markup elements, and to maintain complete separation between the markup and the 
visual presentation of the elements contained in the document.  
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Presentational Markup vs. Semantic Markup 
(in HTML)

Semantic HTMLPresentational HTML

• Title
• Heading
• List
• Paragraph
• Blockquote
• Code
• Definition
• Cite

• Strong
• Bold
• Font size
• Font Color
• Background Color
• Strikethrough
• Underline

24

The current best practice is to use cascading styles --- rather than HTML tags --- for presentational markup.
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Presentational HTML vs. Semantic HTML 
 
A table comparing presentational and semantic HTML. 
 
Presentational HTML 
• Strong 
• Bold 
• Font size 
• Font Color 
• Background Color 
• Strikethrough 
• Underline 
 
Semantic HTML 
• Title 
• Heading 
• List 
• Paragraph 
• Blockquote 
• Code 
• Definition 
• Cite 
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Presentational Markup vs. Semantic Markup 
(in Microsoft Word)

Semantic MarkupPresentational Markup

• Title
• Header
• Definition
• Language
• Numbered list
• Table
• Label
• Footnote
• Caption
• Citation
• Hyperlink
• Quote

• Bold
• Italic
• Underline
• Strike-through
• Highlight
• Text color
• Borders
• Font-face

• font-size

Appearance vs. Significance

Bouton Jones 25

 

 

Presentational Markup vs. Semantic Markup 
  
IMAGE: A table listing examples of presentational markup and semantic markup. 
 
Presentational Markup 

• bold 

• italic 

• underline 

• red, green, blue, etc., 

• borders 

• font-face 

• font-size 

• strike-through 

• line break 
  
Semantic Markup 

• title 

• header 



• definition 

• language 

• numbered list 

• table 

• label 

• footnote 

• caption 

• citation 
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Language Tagging
FILE tab > Options option > Language option > Select language > Click OK button

Bouton Jones 26

 

 

Language Tagging 
 
In Word:  FILE tab > Options option > Language option > Select language > Click OK button 
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Presentational Markup for Titles and Headers
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Presentational Markup for Titles and Headers in Microsoft Office 
 
IMAGE: Screen capture of a Word document with the title selected by the cursor and a red 
rectangle surrounding the FONT presentation setting. 
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Sematic Markup for Titles and Headers

Bouton Jones 28

 

 

Semantic Markup for Titles and Headers in Microsoft Office 
 
IMAGE: Screen capture of a Word document with the title selected by the cursor and a red 
rectangle surrounding the Title tag in the Semantic formatting setting. 
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Do You Need to Choose Between Appearance 
or A11y?

First apply semantic tagging.

Second apply visual formatting.

Bouton Jones 29

 

 

You Don’t Have to Sacrifice Appearance for A11y. 
  

• Apply semantic tagging 

• Apply visual formatting 
  
You don’t want to apply the semantic tagging after the visual formatting.  The visual formatting 
will revert to the default heading style (which I expect you don’t want.) 
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Customize or Create New Styles in Word

1. Select text in your document that has the style applied, such as 
Heading 1.

2. Format the selected text with the new attributes that you want. 

3. On the Home tab, in the Styles group, right-click the style that you 
want to change, and then click Update [Style Name] to Match 
Selection.

CITE: https://support.office.com/en-ie/article/customize-or-create-new-styles-in-word-d38d6e47-f6fc-48eb-a607-1eb120dec563

Bouton Jones 30

 

 

Customize or Create New Styles in Word 
  
[IMAGE: Screen capture of the Styles tabs in the MS Word Ribbon] 
  

• Select text in your document that has the style applied, such as Heading 1.  

• Format the selected text with the new attributes that you want.  

• On the Home tab, in the Styles group, right-click the style that you want to change, and 
then click Update [Style Name] to Match Selection. 

  
CITE: https://support.office.com/en-ie/article/customize-or-create-new-styles-in-word-
d38d6e47-f6fc-48eb-a607-1eb120dec563  
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The Proper Order of Titles and Headings

WRONGRIGHT

Heading 1
• Heading 2

• Heading 3

• Heading 3

• Heading 2
• Heading 3

• Heading 3

Heading 1
• Heading 3

• Heading 5

• Heading 5

• Heading 3
• Heading 5

• Heading 5

Bouton Jones 31

 

 

The Proper Order of Titles and Headings 
 

Don’t skip header levels. 
 
[IMAGE: Screen capture of the Styles tabs in the MS Word Ribbon] 
 
Table with two columns and two rows. 
 

Right 
  
• Heading 1 

• Heading 2 
• Heading 3 
• Heading 3 

• Heading 2 
• Heading 3 
• Heading 3 

  
Wrong 
  
• Heading 1 

• Heading 3 



• Heading 5 
• Heading 5 

• Heading 3 
• Heading 5 
• Heading 5 
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Displaying the Word Navigation Pane
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Displaying the Word Navigation Pane 
 
IMAGE:  Screen capture shows the navigation panel in Word.  The “Navigation Pane” 
checkbox under the file tab is checked. 
 
• Select the View tab 
• Check the Navigation Pane Checkbox. 
  
"A non-web example of the benefits of a structural approach to content markup can be 
found when using Microsoft Word. If headings are used consistently throughout a 
document, then a table of contents can be generated auto-magically. If text has only 
been styled to look like a heading, then the program cannot distinguish headings from 
body copy, and the resulting table of contents is likely to be meaningless.“ 
  
CITE: http://www.motive.co.nz/glossary/markup.php   
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Adding a Table of Contents
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Adding a Table of Contents 
 
IMAGE:  Screen capture of Table of Contents panel in MS Word. 
 
Assuming you have been using header tags correctly:  
• Put your cursor where you want to add the table of contents. 
• Go to References > Table of Contents, and choose Automatic Table 1 or Automatic Table 2. 
• If you make changes to your document that affect the table of contents, update the table of 

contents by right-clicking the table of contents and choosing Update Field. 
 
CITE: https://support.office.com/en-ie/article/insert-a-table-of-contents-882e8564-0edb-435e-
84b5-1d8552ccf0c0 
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Table of Contents Example
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Table of Contents Example (Screen Capture) 
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Avoid Using Tables for Layout

Tabular Data Layout

This guideline is more important for web pages (HTML) than MSO or PDFs.  And it’s less important if you don’t 
include a header row.

Bouton Jones 35

 

 

Avoid Using Tables for Layout 
 
IMAGES: 
• Tabular Data (screen capture) 
• Layout (screen capture) 
 
This guideline is more important for web pages (HTML) than MSO or PDFs. 
 
If you must use tables for layout, don’t include column headers. 
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Properly Tagging Tables in MS Office

Microsoft 
Word

Microsoft 
PowerPoint

Microsoft 
Excel

Specify column header information in tables (through Semantic Markup.)

Bouton Jones 36

 

 

Specify column header information in tables (through Semantic Markup.) 
  
Three SCREEN Captures: Select the table styles that include header rows: 
• In Word 
• In PowerPoint 
• In Excel 
 
 

  



Slide 37 

 

Include Header Rows in Tables When 
Inserting Tables in Word

1. In Word, select the INSERT tab and then the Table icon.

2. Check the Header Row option under the DESIGN (TABLE TOOLS) tab.

Bouton Jones 37

 

 

Include Header Rows in Tables When Inserting Tables in Word 
  

• In Word, select the INSERT tab and then the Table icon. 

• Check the Header Row option under the DESIGN (TABLE TOOLS) tab. 
  
IMAGES:  screen captures to illustrate both steps 
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Repeat Header Rows Across Pages
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Header Rows Across Pages 
 
IMAGE: Screen Capture of Word document with table selected.   
 
• Select the table 
• Select the Layout tab (in the Table Tools group.) 
• Select the Repeat Header Rows function 
 
Or, you can use this approach: 
1. In the table, right-click in the row that you want to repeat, and then click Table Properties. 
2. In the Table Properties dialog box, on the Row tab, select the Repeat as header row at the top 
of each page check box. 
3. Select OK. 
 
CITE: https://support.microsoft.com/en-us/office/repeat-table-header-on-subsequent-pages-
2ff677e0-3150-464a-a283-fa52794b4b41 
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Add Alternative Text in Word
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Add Alternative Text in Word 
 
You can add alt text to an image in Word similarly to adding it in HTML. When you export the 
Word document to PDF the Alt text will be exported as well. 
 
• Select picture and right click 
• Select “Format Picture” from the Context menu 
• Select the “Layout & Properties” icon in the Format Picture menu 
• Select ALT TEXT option 
• Populate the Title and/or the Description 
• Close the Format Picture menu.  Your changes will be saved. 
 
[IMAGES:  screen captures to illustrate the Context menu and the Format Picture menu] 
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Inserting Captions in Word
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Inserting Captions in Word 
 
• Select the Reference tab  
• Select the Insert caption icon 
• Populate the Caption window which will open 
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Flair

Not A11y

• Word Art

• Text Boxes

• Tables for layout

Not Equitable

• Page borders

• Watermarks / Backgrounds

• Headers & Footer
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Resist Flare 
 
Features that are not accessible: 
• Word Art 
• Text Boxes 
• Tables used for layout. 
 
Features that are not equitable: 
• Page borders 
• Watermarks / Backgrounds 
• Headers & Footer 
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Validate Word for Accessibility

PITFALL: Recent editions of Microsoft Word include a built in accessibility checker. But in order 
for the accessibility check to run on a document, the document must be saved with the default 
.docx extension. If you try to save the document using another format -- such as .doc -- the 
accessibility checker won't run. 
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 Validate Word for Accessibility 
  
To validate your Microsoft Word document (*.docx) in Word: 
  

• Select the file tab in the Office Ribbon. 

• In the File view, select the Info option 

• Select the Inspect Document button. 

• Select the Check Accessibility option 
  
PITFALL:  Recent editions of Microsoft Word include a built-in accessibility checker. But for the 
accessibility check to run on a document, the document must be saved with the default .docx 
extension. If you try to save the document using another format -- such as .doc -- the 
accessibility checker won't run.  
 
 

  



Slide 43 

 

Check accessibility while you work
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Check accessibility while you work 
 
• Select the File tab 
• Select the More … option 
• In the Word Options window, select the Ease of Access option in the left-hand side 

navigation panel 
• Check the check box for “Keep accessibility checker running while I work.” 
• Click the OK button.   
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Adobe Acrobat Accessibility

 

 

Adobe Acrobat Accessibility (title slide) 
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Making Accessible PDFs by
Remediation in Acrobat
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Making Accessible PDFs by Remediation in Acrobat 
  
The Make Accessible Action Wizard in Adobe Acrobat 

• Choose Tools > Action Wizard. 

• From the Action List, click Make Accessible. 

• Select the files that you want to apply the Make Accessible action to. 

• Click Start. 

• Follow the prompts to complete the Make Accessible action. 
  
SPOILER ALERT:  Based on my experience, I still recommend that you start with a fully 
accessible document (e.g. Word) and convert it to PDF.  It’s more efficient and a better use of 
your time than applying accessibility to a non-accessible --- or marginally accessible --- PDF. 
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Show the Tag Pane
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Show the Tag Pane 
  
IMAGE: Screen capture 
  

• Select the drop-down menu for View 

• Select the Show / Hide option 

• Select the Navigation Panes option 

• Select the Tags option 
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Artifacts

In PDFs, an artifact is a purely decorative image that can be (and should 
be) ignored by screen reading software.
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Artifacts 
 
IMAGE:  Archeological artifacts 
 
In PDFs, an artifact is a purely decorative image that can be and should be ignored by screen 
reading software. 
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Artifact Examples

Purely decorative images

Redundant Company Logos and Government Seals

Table borders incorrectly identified as images by OCR in scanned 
PDFs

Fancy bullet points (like the ones here.)

Headers and Footers (when exporting from MSO documents)
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Artifact Examples 
 
• Purely decorative images 
• Redundant Company Logos and Government Seals 
• Fancy bullet points 
• Table borders incorrectly identified as images by OCR in scanned PDFs 
 
Ask whether including descriptions would aid in making an equitable experience? 
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Remove the Table tags for the layout tables

Bouton Jones 49

In the tab pane, select the <Table> tag and 
delete it.

The page layout will remain the same ---
including the table content --- but assistive 
technology will not treat it as a table.

This is like the “role=‘presentation’“ 
technique in HTML but applied to PDF.

 

 

Remove Layout Tables in Adobe Acrobat 2017 
 
Remove a Table 
 
• Select Tools 
• Select Edit PDF 
• Select Tag to see the tag tree 
• Select the table with a right click 
• Select the Delete Tag option from the context menu 
 
The challenge here is to identify the correct tag.  They are not well labeled and it’s hard to 
identify which item in the document they correspond to. 
 
IMAGE: Screen Capture showing how to remove a table tag from the tag tree. 
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Acrobat 2017 A11y Demo (VIDEO)
How to Create Accessible in PDF [SIC] by Using Adobe Acrobat Pro [2017] (1:50) https://youtu.be/1NUwbF_ZjiY
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Acrobat A11y Demo (VIDEO) 
  
How to Create Accessible in PDF [SIC] by Using Adobe Acrobat Pro [2017] (1:50) 
CITE: https://youtu.be/1NUwbF_ZjiY  
  
In this video, PDF Tutorial: How to Create Accessible in pdf by using adobe acrobat pro -
2017. Go to the tool menu and click the Action Wizard and Click Create Accessible 
  
00:00  In this video, PDF Tutorial: How to Create Accessible in pdf by using adobe 
acrobat pro  
00:01  Go to the tool menu and click the Action Wizard and Click Create Accessibly  
00:11  select the Add Document Description and click ok and select destination  
00:22  fill the information  
01:00  now your accessibility is created  
01:40  Please Subscribe My channel Thank you for watching  
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Validate PDFs for A11y in Acrobat
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Validate PDFs for A11y in Acrobat 
  

• Choose Tools > Accessibility. 

• In the secondary toolbar, click Full Check. 

• In the Report Options section, select options for how you want to view the results.  

• Select one or more of the Checking Options. 

• Click Start Checking. The results are displayed in the Accessibility Checker panel on the 
left. 

  
Spoiler Alert:  Don’t reply solely on automated reports to check a11y. Manual testing is 
obligatory. 
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Adobe Acrobat Accessibility Checker Options
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Adobe Acrobat Accessibility Checker Options 
 
IMAGE: Adobe’s Accessibility Check Options 
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Adobe Acrobat Accessibility Report
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Adobe Acrobat Accessibility Report 
 
IMAGE:  Screen capture of a Adobe Acrobat Accessibility Report 
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PDF Accessibility Checker (PAC)
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PDF Accessibility Checker (PAC) 
 
PAC’s 14 Testing Criteria: 
 
• Document is marked as tagged 
• Document Title available 
• Document Language defined 
• Accessible Security Settings 
• Tab follows Tag-Structure 
• Consistent Heading Structure 
• Bookmarks available 
• Accessible Font Encodings 
• Content completely tagged 
• Logical Reading Order 
• Alternative Text available 
• Correct Syntax of Tags / Rolls 
• Sufficient contrast for Text 
• Spaces existent 
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Adobe Acrobat UI for Remediation

Bouton Jones 55

• Acrobat has multiple panes (“modes”) for 
modifying documents. E.G. edit tags, re-order tags, 
edit PDF, etc.,  It’s cumbersome and confusing to 
move between them.

• Performing certain functions are involved.  It takes 5 clicks to 
perform OCR!

• I think the UI for remediation in Adobe Acrobat is awful, but I’ve 
recently seen improvements.

 

 

Adobe Acrobat UI for Remediation 
 
I think the UI for remediation in Adobe Acrobat is awful, but I’ve recently seen improvements. 
 
Acrobat has multiple panes (“modes”) for modifying documents. E.G. edit tags, re-order tags, 
edit PDF, etc.,  It’s cumbersome and confusing to move between them. 
 
Performing certain functions are involved.  It takes 5 clicks to perform OCR! 
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A Book about PDF Remediation

Fix PDF Files for Accessibility: The Easy and 
Ultimate Guide to Applying Section 508 and 
WCAG 2.0 to PDF Files 

1st Edition

by Ed Thrush 

Paperback : 148 pages

ISBN-10 : 1514608936

ISBN-13 : 978-1514608937

https://www.amazon.com/Fix-PDF-Files-
Accessibility-Ultimate/dp/1514608936/
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A Book about PDF Remediation 
  
Fix PDF Files for Accessibility: The Easy and Ultimate Guide to Applying Section 508 and WCAG 
2.0 to PDF Files  
1st Edition 
by Ed Thrush  
Paperback : 148 pages 
ISBN-10 : 1514608936 
ISBN-13 : 978-1514608937 
  
https://www.amazon.com/Fix-PDF-Files-Accessibility-Ultimate/dp/1514608936/  
  
AMAZON.com DESCRPTION:  This book provides the easiest way to get to the required 
accessibility of a PDF file. It is rare for any PDF to come out perfect for accessibility and as a 
result almost all PDF files will need some type of work. In addition to the easy nuts and bolts 
methods to make PDF files work for the disabled, there are also condensed methods for 
preparation of documents commonly converted to PDF. In addition, there are instructions for 
managers and even contract language. You can get a legal history or technical lesson elsewhere, 
this book is for getting to work fixing PDF files for accessibility. 
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Optical Character Recognition
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Optical Character Recognition (OCR) [Title Slide] 
  
Optical character recognition or optical character reader is the electronic or mechanical 
conversion of images of typed, handwritten or printed text into machine-encoded text, whether 
from a scanned document, a photo of a document, a scene-photo or from subtitle text 
superimposed on an image.  
  
CITE: Wikipedia 
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OCR in Adobe Acrobat 2017
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OCR Steps in Adobe Acrobat 2017 
 
• Select the Tools tab 
• Select the Enhance Scans icon 
• Select the Recognize Text menu 
• Select the In This File Option 
• Select the Recognize Text button 
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Acrobat XI OCR Demo (Video)

59

OCR: How To Convert Scanned Document (PDF) To Text Using Adobe Acrobat Professional (0:37)
https://youtu.be/WqRHwWp5kyg
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OCR Demo (Video) 
  
OCR: How To Convert Scanned Document (PDF) To Text Using Adobe Acrobat Professional (:37) 
  
This video has no narration, transcript, or close captioning. 
  
In this video a PDF is displayed inside Adobe Acrobat.  The user tries to select the text.  But the 
PDF is image only so the text cannot be selected.  The user runs OCR on the entire PDF.  The 
pages are de-skewed (i.e. straightened) The text inside the images are converted into real text.  
They appear to retain the original fancy font face. 
  
CITE:  https://youtu.be/WqRHwWp5kyg   
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How Reliable is the OCR?
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How Reliable is the OCR? 
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Three Ways to Check the OCR Accuracy

1. Compare the visible text to what a screen reader finds.

2. Copy and paste the newly editable text into a text document.

3. Change the font face --- of the editable text --- throughout the 
revised document.  (Later you can change it back to the fonts 
closest to the original document’s fonts.)
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Three Ways to Check the OCR Accuracy 
 
• Compare the visible text to what a screen reader finds. 
 
• Copy and paste the newly editable text into a text document. 
 
• Change the font face --- of the editable text --- throughout the revised document.  (Later you 

can change it back to the fonts closest to the original document’s fonts.) 
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More About OCR

The “PDF A11y 102” session includes more about OCR.

Bouton Jones 62
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John Robert Wooden (1910-2010) was an American basketball player and head coach at the University of California at Los Angeles.
Bouton Jones

My Take-away

63

It’s better to export a fully accessible Office document into PDF than to remediate in-accessible PDFs. 

 

 

My Take Away 
 
I think it’s better to export a fully accessible Office document into PDF than to remediate in-
accessible PDFs.   It’s faster, easier, and more reliable. 
 
IMAGE:  John Wooden face and quote. 
 
“If you don’t have time to do it right.  When will you have time to do it over?”  
 - John Wooden 
 
Meaning here: 
• You're not going to accidentally make something accessible. 
• Accessibility is not expensive if done right 
• Accessibility is best incorporated at every step of the development process.  Accessibility is 

not something you add at the end. 
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But wait! I can hear what someone is 
thinking …
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But wait!  I can hear what someone is thinking … 
 
IMAGE:  Doctor X of the X-men reading minds. 
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“Hey, Mr. Smarty-pants!  What if the original 
source document doesn’t exist?  What then?!?”

Is that a Fact or assumption?

What will remediation entail?

How long will remediation take?

Can the source document be reproduced?
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“Hey, Mr. Smarty-pants!  What if the original source document doesn’t exist?  What then?!?” 
 

• Is that a Fact or assumption? 

• What will remediation entail? 

• How long will remediation take? 

• Can the source document be reproduced? 
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Convert PDF to Microsoft Word

CITE: https://www.howtogeek.com/360499/how-to-convert-a-pdf-to-a-microsoft-word-document/

• Acrobat DC (best solution but also the most expensive) 
• Adobe Reader ($12.99 per month for this functionality)
• Microsoft Word (can lead to formatting issues)
• Google Docs 
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Convert PDFs to Microsoft Word 
 
If at all possible:  Convert PDFs to MS Word, make the Word documents accessible, and 
then convert to PDF. 
 
From "How to Convert a PDF to a Microsoft Word Document" by HAYLEY MILLIMAN  
AUGUST 3, 2018, 10:24AM EDT 
 
• Acrobat DC (best but expensive) 
• Adobe Reader ($12.99 per month) 
• Microsoft Word 
• Google Docs  
 
“PDFs are often used when distributing documents so that they’re seen the same way by 
all parties. Because they’re designed in this way, they can be quite difficult to edit. You 
may want to convert your PDF to a Word document so that you can make changes to 
your text more easily.” 
 
“Adobe’s own Acrobat DC and Acrobat Reader DC both offer an easy way to convert PDF 
files to Word documents. The bad news is that it ain’t free. The full Acrobat DC has a 
standard version (Windows only) that runs $12.99 per month and a pro version 



(Windows and Mac) that runs $14.99 per month. And both require an annual 
commitment. Pretty overkill if all you need to do is convert a PDF to Word format once in 
a while. But if you already have Acrobat DC, then you should use that convert your 
PDFs.” 
 
“Acrobat Reader DC, on the other hand is free, but you’ll need to pony up a $1.99 per 
month fee if you want it to be able to convert PDFs to other formats, like Word. If it’s 
something you need to do regularly, that fee is probably worth it because using Acrobat 
is the most reliable way to change your PDFs to Word documents, since it tends to 
maintain formatting pretty well.” 
 
“You can also convert your PDF to a Word document using just Microsoft Word. 
Converting in Word often leads to style and formatting issues, so it’s not always the most 
reliable method. However, it certainly works well enough for simple documents or when 
you just need to get stuff into an editable format.” 
 
“Google Docs provides another safe and reliable way to convert your PDF to a Word 
document.” 
 
CITE: https://www.howtogeek.com/360499/how-to-convert-a-pdf-to-a-microsoft-word-
document/ 
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Additional Considerations

• Bookmarks

• Reflow

• Liquid Mode

• Fillable Forms

• Redaction
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End User Added Bookmarks 

• Bookmarks are links in the 
navigation panel of PDFs.  They 
allow jumping to specified 
topics. 

• End users can create their own 
bookmarks in existing PDFs.
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Bookmarks 
 
Bookmarks are links in the navigation panel of PDFs.  They allow jumping to the specified topic.  
 
End users can create their own bookmarks in PDFs. 
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A11y Guidelines for Bookmarks

• The TOCs of Word documents can be exported as 
bookmarks in PDFs.  (And those TOCs are based on 
the headings.)

• The Acrobat checker gives an error if bookmarks 
are not present in a document longer than 20 
pages.

• Some A11y professionals advise: if you use 
Bookmarks, they should mirror headings.
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Bookmarks 
 
Bookmarks are links in the navigation panel of PDFs.  They allow jumping to the specified topic.  
 
End users can create their own bookmarks in PDFs. 
 
The TOCs of Word documents can be exported as bookmarks in PDFs.  (And those TOCs are 
based on the headings.) 
 
The Acrobat checker gives an error if bookmarks are not present in a document longer than 20 
pages. 
 
Some A11y professionals advise: if you use Bookmarks, they should mirror headings.  
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From HHS.gov’s Guidelines 

URL: https://www.hhs.gov/web/section-508/making-files-accessible/pdf-required/index.html
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Thanks to David Comeau for referring me to this page

 

 

From HHS.gov’s Guidelines  
 
SCREEN CAPTURE: Sections of a table from the “Required Fixes for PDF Files” page on the  
HHS.gov website.  It consists of two rows and three columns 
 
First Row 
 
Issue Title: Bookmarks Unavailable for Document >=10 pages  
 
Issue Description: The document contains at least 10 pages and does not contain proper 
bookmarks. This issue is a violation of section 508 and WCAG 2.0 Success Criterion 2.4.5. 
<http://www.w3.org/TR/UNDERSTANDING-WCAG20/navigation-mechanisms-mult-loc.html> 
 
Remediation Suggestion: Add bookmarks for major divisions of the document. Recommend 
creating based on the heading structure or Table of Contents if one exists. For assistance see: 
W3 PDF Technique #2 <http://www.w3.org/TR/2015/NOTE-WCAG20-TECHS-20150226/PDF2> 
Adobe Bookmark <https://helpx.adobe.com/acrobat/using/create-verify-pdf-
accessibility.html?trackingid=KACNN#Bookmarks> 
 
Second Row 
 
Issue Title: Bookmarks are inaccurate  
 



Issue Description: There are multiple bookmarks to the same place, incorrect titles/names, or 
locations are out of order. This issue is a violation of section 508 and WCAG 2.0 Success 
Criterion 2.4.5. <http://www.w3.org/TR/UNDERSTANDING-WCAG20/navigation-mechanisms-
mult-loc.html> 
 
Remediation Suggestion: Add, remove, or rearrange bookmarks. Recommend creating based on 
the heading structure or Table of Contents if one exists. For assistance see: W3 PDF Technique 
#2 <http://www.w3.org/TR/2015/NOTE-WCAG20-TECHS-20150226/PDF2> 
Adobe Bookmarks <https://helpx.adobe.com/acrobat/using/create-verify-pdf-
accessibility.html?trackingid=KACNN#Bookmarks> 
 
URL:  https://www.hhs.gov/web/section-508/making-files-accessible/pdf-
required/index.htmlhttps://www.hhs.gov/web/section-508/making-files-accessible/pdf-

required/index.html 
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WCAG Success Criterion 2.4.5

Multiple Ways: More than one way is available to locate a Web page 
within a set of Web pages except where the Web Page is the result of, 
or a step in, a process. (Level AA)

Intent of Success Criterion:  The intent of this Success Criterion is to 
make it possible for users to locate content in a manner that best 
meets their needs. Users may find one technique easier or more 
comprehensible to use than another.
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WCAG Success Criterion 2.4.5 
 
Multiple Ways: More than one way is available to locate a Web page within a set of Web pages 
except where the Web Page is the result of, or a step in, a process. (Level AA) 
 
Intent of Success Criterion:  The intent of this Success Criterion is to make it possible for users to 
locate content in a manner that best meets their needs. Users may find one technique easier or 
more comprehensible to use than another. 
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PDF2 (WCAG 2.0 Technique): Creating 
bookmarks in PDF documents

“The intent of this technique is to make it possible for users to locate content 
using bookmarks (outline entries in an Outline dictionary) in long 
documents.

“A person with cognitive disabilities may prefer a hierarchical outline that 
provides an overview of the document rather than reading and traversing 
through many pages. This is also a conventional means of navigating a 
document that benefits all users.”

URL: https://www.w3.org/TR/2016/NOTE-WCAG20-TECHS-20161007/PDF2
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PDF2 (WCAG 2.0 Technique): Creating bookmarks in PDF documents 
 
The intent of this technique is to make it possible for users to locate content using bookmarks 
(outline entries in an Outline dictionary) in long documents. 
 
A person with cognitive disabilities may prefer a hierarchical outline that provides an overview 
of the document rather than reading and traversing through many pages. This is also a 
conventional means of navigating a document that benefits all users. 
 
URL: https://www.w3.org/TR/2016/NOTE-WCAG20-TECHS-20161007/PDF2 
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My Minority Opinion on Bookmarks

• The Acrobat checker gives an error if bookmarks are not present in a 
document longer than 20 pages.

• Section 508 requires Federal agencies to include bookmarks in a PDF 
if the document is ten or more pages long.

• WCAG allows for bookmarks as one technique for Success Criterion 
2.4.5
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My Conclusion for Bookmarks 
 
• The Acrobat checker gives an error if bookmarks are not present in a document longer than 

20 pages. 
 
• Section 508 requires Federal agencies to include bookmarks in PDF if the document is ten or 

more pages long 
 
• WCAG allows for bookmarks as one technique for Success Criterion 2.4.5 
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How Do You Use Word Headings for 
Bookmarks?

Bouton Jones 74

How to add bookmarks based on a 
document’s structure via Adobe Acrobat 
Pro DC:

1. Select Bookmarks icon on the 
Accessibility Checker panel

2. Select the Options icon
3. Select New Bookmarks from 

Structure
4. In the Structure Elements dialog box, 

select the element(s) that you want 
to use as bookmarks.

5. Click OK.

CITE: 
https://accessiblewebsiteservices.com/a
ccessible-pdfs-when-bookmarks-are-
required/

 

 

How Do You Use Word Headings for Bookmarks? 
 
How to add bookmarks based on a document’s structure via Adobe Acrobat Pro DC: 
 
1. Select Bookmarks icon on the Accessibility Checker panel 
2. Select the Options icon 
3. Select New Bookmarks from Structure 
4. In the Structure Elements dialog box, select the element(s) that you want to use as 
bookmarks. 
5. Click OK. 
 
CITE: https://accessiblewebsiteservices.com/accessible-pdfs-when-bookmarks-are-required/ 
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Create Bookmarks Based on Heading in Word
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Create Bookmarks Based on Heading in Word 
 
IMAGE:  Screen Capture of the Options window for the Save As window. 
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Convert Word Headings to Bookmarks Using 
Acrobat PDFMaker
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Convert Word Headings to Bookmarks Using Acrobat PDFMaker 
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About Fillable Forms

• Make sure the labels and names of the input fields are correct

• Make sure the tab order of the input fields is correct
• Form fields are listed in the order they were added.

• The tool tips should match the labels

• Date field tool tips should contain a text string showing the correct 
date format (e.g. “mm/dd/yyyy.”)
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About Fillable Forms 
 
• Make sure the labels and names of the input fields are correct 
• Make sure the tab order of the input fields is correct 

• Form fields are listed in the order they were added. 
• The tool tips should match the labels 
• Date field tool tips should contain a text string showing the correct date format (e.g. 

“mm/dd/yyyy.”) 
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About Redaction

• Why redaction?

• Don’t go old school.  Redact 
electronically. 

• Redact electronically the right way. 

• Return to Document View mode 
before saving a redacted document.   
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About Redaction 
  
IMAGE:  Haben Girma, an American disability rights advocate, and the first deafblind graduate 
of Harvard Law School. 
  

* Lawyers and paralegals might be blind. 

* Don’t manually redact hard copies and scan them.  Redact electronically.   

* Redact electronically the right way.  Don’t make the same mistake as the lawyers for Paul 
Manafort and former Illinois Governor Rod Blagojevish. 

* Save your changes:  Return to Document View mode before saving a redacted document.   
Close the other modes. 
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Final Considerations

• Do you truly need to use a PDF (instead of a web 
page) to show attestation?  (IANAL.)

• Use Accessible color combinations and color 
contrasts.

• Syntax and Language: KISS. 

• Manually Test A11y.  

• Provide accessible MSO templates for your 
organization’s content providers’ use.

• Use WCAG and PDF/UA for guidance 

Bouton Jones 79

 

 

Other Considerations 
 
• Do you truly need to show attestation by using a PDF instead of  web page?  IANAL.  Check 

with your lawyer(s). 
• Apply WCAG’s accessible color contrast guidelines. 
• Syntax and language: KISS. 

• Write in plain language.  Choose words that are common and easy to understand. 
• Use clear, short sentences and paragraphs. Avoid run-on sentences.  
• Your content should be written in the active voice instead of the passive voice.  (Or 

more correctly: Write your content in the active voice instead of the passive voice.) 
• Avoid using acronyms, abbreviations, and text messaging syntax that would sound 

strange if read by a screen reader or that could be confusing to some readers. (e.g. 
“Tunatexas.gov”) 

• Limit your use of hashtags.  But when you do, use camel case (e.g. #CityOfArlan, 
#TunaTexas) 

• "It [Plain Language] is easily searchable and will often gain you a better SEO ranking. 
The words that you use in your copy should reflect the words people enter in search 
engines." - Hoa Loranger "Plain Language Is for Everyone, Even Experts" 
https://www.nngroup.com/articles/plain-language-experts/ 

• When you use an acronym for the first time in an article or web page, use the long 
name first (spell it out) and follow that with the acronym in parenthesis.   For 
example: "The Human Resource Department (HRD) has the finest ColdFusion 



development team in the City of Austin.  HRD has long been recognized for it's IT 
excellence."  

• Microsoft Word’s built-in grammar checker, Grammarly, and Hemingway 
• Manually test A11y.  Recruit people with disabilities (e.g. blind users, people with limited 

vision, people who are color blind, and people with dyslexia.) 
• Provide accessible Microsoft Office document templates for your organization’s content 

providers use. 
• Follow WCAG and PDF/UA for guidance (with a preference for WCAG.) 
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Summary

• Only use PDFs when they are the best option.

• It’s better to remediate and export a source document to PDF than to 
remediate an inaccessible PDF.

• Check the accessibility of your source documents using automated 
and manual testing.

• Never print to PDF.  Always export to --- or save as --- PDF.

• If you must scan to PDF, then perform OCR and remediate.

• Check the accuracy of OCR and correct when necessary.  

• Test the accessibility of your PDFs using automated and manual 
testing.
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Summary 
 
• Only use PDFs when they are the best option. 
• It’s better to remediate and export a source document to PDF than to remediate an 

inaccessible PDF. 
• Check the accessibility of your source documents using automated and manual testing. 
• Never print to PDF.  Always export to --- or save as --- PDF. 
• If you must scan to PDF, then perform OCR and remediate. 
• Check the accuracy of OCR and correct when necessary.   
• Test the accessibility of your PDFs using automated and manual testing. 
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Next: PDF A11y 201

• The PDF/UA Guidelines

• The Matterhorn Protocol

• More on OCR Accuracy

• Embedding Fonts in Word and PDFs

• What are the Base 14 fonts?

• How should AT address the content in headers and footers and what 
does that mean to document authors?

• When are "article threads" an issue?

• What is XFA and when is it a problem?
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Next: PDF A11y 201 
 
• The PDF/UA Guidelines 
• The Matterhorn Protocol 
• More on OCR Accuracy 
• Embedding Fonts in Word and PDFs 
• What are the Base 14 fonts? 
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Any Questions?
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Any Questions? 
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Thank You For Your Time!
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Thank You.  This concludes this session. 
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Hacking Redacted PDFs

Open the Slides for “Hacking Redacted PDFs”
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Reflow

• Can you easily read your PDF on a mobile phone?   Or must you resize the 
PDF and scroll horizontally and vertically in order to read all the content?

• Have you enabled reflow (for low vision users) in your PDF?  And is your 
PDF optimized for reflow?

• See VIDEO: "How to make PDFs accessible for emergency communications“ 
(September 11, 2020) from Deque Systems (59:11) at 
https://www.youtube.com/watch?v=Tl5vQeTLX4M for more on this.
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Reflow 
 
• Can you easily read your PDF on a smart phone?   Or must you resize the PDF and scroll 

horizontally and vertically in order to read all the content? 
• Have you enabled reflow (for low vision users) in your PDF?  Is your PDF optimized for 

reflow? 
• See VIDEO: "How to make PDFs accessible for emergency communications" from Deque 

Systems (59:11) at https://www.youtube.com/watch?v=Tl5vQeTLX4M for more on this. 
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Enable Reflow from Word (Step 1 & 2)
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Enable Reflow from Word (Step 1 & 2) 
 
IMAGE:  Acrobat ribbon in Word with Create PDF highlighted 
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Enable Reflow from Word (Step 3 & 4)
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Enable Reflow from Word (Step 3 & 4) 
 
IMAGE:  Screen capture of the Acrobat PDFMaker window. 
 
In the following dialog box, select the Options button: 
 
option button for saving as a pdf 
 
Make sure the box is checked for “Enable Accessibility and Reflow with tagged Adobe PDF” 
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Liquid Mode
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Liquid Mode 
 
"Liquid Mode lets you effortlessly read PDFs on phones, tablets, and Chromebooks — no 
pinching and zooming necessary. You can maximize your comfort with readability controls to 
adjust the default font size, character spacing, and line spacing." (CITE: 
https://acrobat.adobe.com/us/en/mobile/acrobat-reader.html viewed on 3/26/2019) 
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Confirm previous slide with example
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Before and After  Removing Table Tags
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Other Checkers
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Bouton clicked the “End” button again!

Previous slide
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Click this button to return to the previous slide. 
 
 

 


